
____________________________________ CHAPTER 18 

Plan and Profile Sheets 
18.1   Overview of Features 
Feature / Function Drawing of plan or plan / profile sheets. 

Tool 

   

Project Manager (Road) Plan and Profile Sheets 

Menu Application GEOPAK Road > Plans Preparation > Plan and Profile Sheets 

 

GEOPAK 2001MR 

The main feature of the 2001 Plus application is a simplified user interface, compared to the Classic 
application.  In this way, users can quickly and easily generate a variety of plan, plan / profile and 
tabular data sheets. 

In order to maintain compatibility with the Classic application and ease the transition for those users 
who want to utilize the 2001 Plus application, 2001 Plus supports importing .dat files utilized in the 
Classic application, and converting them to the new Port-oriented format.  Dat files were the 
equivalent of the Sheet Library in the Classic application. 

2001 Plus supports any combination of Ports on a sheet for maximum flexibility. 

2001 Plus provides powerful handling of MicroStation reference files.  This is accomplished by having 
other MicroStation files serve as patterns for the reference file attachments.  These are called motif 
files. 

2001 Plus has the option to automatically make a notch in the clipping shape at layout time to make 
room on the sheet for a title block.  This is done by putting the clipping shape pattern into the sheet 
cell. 

Extended Stationing is used as a means to allow sheets to be placed partially off of an alignment or 
even completely off of the alignment. 

2001 Plus has the ability to place sheets with a Right to Left Station progression, which is opposite of 
the standard used in roadway design.  This was added for users doing rail design. 

A thorough capability is provided to perform sheet numbering.  Alphanumeric prefixes and suffixes as 
well as changing the start number of the sheets and rearranging the ordering are all supported in 
2001 Plus. 

2001 Plus supports Profile Stair Stepping.  In situations with steep grades or narrow profile ports, 
sometimes the profile goes off the top or bottom of the port before it gets to the end of it.  To handle 
this, users would put a break in the profile port and adjust the elevations to bring the coverage up or 
down to where it needs to be.  Within 2001 Plus, GEOPAK automatically locates these breaks and 
plots the profile clipping shapes in accordance with that.  This adjustment carries through, then, to the 
sheet design file. 
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Profile Gap Equalities -- If a Profile has been plotted with the Gap option turned on, the coverage of 
the sheet is now adjusted so that subsequent sheets remain aligned with the grid. 

Raster Manager -- Descartes is not supported by the application.  Raster Files are now to be 
referenced via the Raster Manager application available via Bentley Select. 

Tabular Data Application -- Sheet Clip places Clipping Shapes suitable for Tabular Data.  However, 
the actual placement of the tabular values in the dgn file is now done via the Draw Tabular Annotation 
(Sheet Clip Mode) tool.  This approach allows the power and flexibility of the Draw Tabular Annotation 
application to be used with sheets. 

 

18.2  Invoking 2001 Plus Main Dialog Box 
When the GEOPAK User Preferences is set to 2001 Plus and Plan and Profile Sheet tool is selected, 
the GEOPAK Sheet Layout dialog box depicted below opens. 

 

The dialog box is comprised of the title bar which displays the current Sheet Library, the main menu 
bar, short-cut icons, and the Sheet Name Selector and Plot Scale fields. 

The first time the application is invoked, it opens up a default.psl sheet library located in the 
\geopak\bin\ folder if the configuration variable isn’t defined. 

The Plot Scale will be displayed in the proper units depending on how it is set in the User 
Preferences. 

18.2.1   Sheet Library 

 

The parameters for each sheet are defined in a Sheet Library.  In order to lay out or clip sheets, a 
Sheet Library must be attached to the current session.  The name of the currently attached Sheet 
Library is shown in the title bar.  Sheet Libraries have an extension of psl.  An unlimited number of 
different sheets can be stored within one library. When the user begins the sheet process, they select 
the desired sheet layout from the attached library, which loads the associated parameters. 

If a different Sheet Library is needed, it can be attached via the menu items Sheet > Library > Attach.  
It is also possible to review or make changes to the Sheet Library by selecting Sheet > Library > Edit.  
Detailed information on the set-up of the Sheet Library can be found in the online help section entitled 
"Sheet Library Set-up." 
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18.2.2   Main Menu Bar Overview 

 

Four options are supported in the main menu bar: 

• Sheet 
• Tools 
• View  
• Settings 

18.2.2.1   Sheet Menu Options 
Five tools are supported in the Sheet pulldown and are detailed in the sub-sections below. 

• Library 
• Composition 
• Layout 
• Clip 
• Exit 

18.2.2.1.1   Library 
The Library file contains the various parameters, cells, and dimensions for creating sheets.  In this 
menu option, a new Library can be created, an existing Library can be edited, or the user can define 
(Attach) the desired Library.  For a detailed discussion of setting up and editing a Library, refer to the 
online documentation "Sheet Library Set-Up." 
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18.2.2.1.2   Composition 
This menu item opens the Sheet Composition dialog box, wherein drawing area, overlapping options 
and other project specific variables are defined.  One sample dialog box is depicted below. 

 

18.2.2.1.3   Layout 
The Layout dialog box is utilized to define the GEOPAK Job Number, alignments, and / or profiles for 
the desired sheets.     

 

Fields are also supported for stationing, if only part of the chain is being utilized for sheet layout. 
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18.2.2.1.4   Clip 
Once the sheets have been laid out and any modifications complete, the sheets are ready to be 
clipped and drawn for the final production sheets.  The Clip dialog box is utilized to complete these 
tasks, as detailed below. 

 

18.2.2.1.5   Exit 
Exits the Plan and Profile Sheets application, but does not close the MicroStation file. 

18.2.2.2   Tools Options 
Four tools are supported in the Tools pulldown and are detailed in the sub-sections below. 

• Modify 
• Sheet Number Manager 
• Draw Tabular Annotation (Sheet Clip Mode) 
• Identify Sheet 
 

18.2.2.2.1   Modify 
After the sheets are laid out, the user may want to adjust individual sheets to conform to the project 
limits, etc.  This can be accomplished utilizing the tools in the Modify dialog box, which is illustrated 
below. 
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The two icons in the upper left corner are utilized to Slide sheets (along the alignment, rotating, 
offsetting) and Modify Drawing Area.  The Slide options are illustrated above, while the graphic below 
depicts the Modifying Drawing area. 

 

The user can select the sheet to be modified from the pick list or by graphic identification.  Sheets can 
also follow the movement of the selected sheet, i.e., moving one sheet to left moves all proceeding or 
following sheets to the left by the same amount. 

18.2.2.2.2   Sheet Number Manager 
After the sheets are laid out, the Sheet Number Manager can be invoked as depicted below, 
populated with the current sheets. 

 

The actual sheet number can be modified, prefix and suffix added, and other labeling options by 
utilizing the Edit Sheet Number (fourth icon down in the grouping to the right of the list box). 
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Another option is changing the order the sheets are drawn. 

18.2.2.2.3   Draw Tabular Annotation (Sheet Clip Mode) 
When the Draw Tabular Annotation tool is selected, the Draw Tabular Annotation dialog box is 
opened, as depicted below.  

 

The user can define the tabular data to be included within the plan /profile sheets.   

18.2.2.2.4   Identify Sheet 
Select Identify Sheet, then select and accept a previously placed clipping shape.  GEOPAK 
determines the settings utilized to place the original sheet and automatically populates the dialog box 
with the Sheet Name and Scale.  In addition, the Sheet Name, Scale, Sheet Number and Port are 
displayed in the MicroStation prompt field at the bottom of the screen.  If the parameters for the 
selected sheet are not found within the current library, a warning message is displayed indicating the 
sheet is not found, the name of the current library, and the name of the library used to place the 
original sheet.  
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18.2.2.3   View Menu Options 
Three tools are supported in the View pulldown and are detailed in the table below. 

Filter by Sheet 
Name 

The clipping shapes of the currently selected sheet name are displayed.  A 
MicroStation update view will need to be issued if “Automatic Update” is not 
toggled on. 

Filter by Scale The clipping shapes of the currently selected Scale are displayed.  A 
MicroStation update view will need to be issued if “Automatic Update” is not 
toggled on. 

NOTE:  “Filter By Sheet Name” and “Filter By Scale” can be used together. 

Automatic 
Update 

If this is toggled on when “Filter By Sheet Name” or “Filter By Scale” is 
selected the view is automatically updated. 

 

18.2.2.4   Settings Menu Options 
One tool is supported in the Sheet pulldown and is detailed in the table below. 

Sheet Layout 
Settings 

When the Sheet Layout Settings tool is selected, the dialog box depicted 
below opens.  Three settings are supported within the dialog box including 
Left to Right or Right to Left layout, Stair Stepping for profiles, and sheet 
view attributes. 

 
• Sheet Layout Progression: 

Left To Right (Standard) 
   Right To Left (Rail) 

• Profile Stair Stepping: 
Off 
On 

• Sheet View Attributes: 
Use Current Design File 
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Customize With Motif File 
  

18.2.3   Dialog Box Icons 
Six short-cut icons are supported for ease of use.  These icons correspond to tools located within the 
menu bar pulldowns and are detailed in the table below. 

 
Sheet Composition  (Sheet > Composition). 

 
Layout Sheets  (Sheet > Layout). 

 
Clip Sheets  (Sheet > Clip). 

 
Modify Sheets  (Tools > Modify). 

 
Sheet Number Manager  (Tools > Sheet Number Manager). 

 
ID button (Tools > Identify Sheet). 

 

18.2.4   Sheet Name Selector and Plot Scale 

 

Two parameters are global to the entire application and are shown on the main dialog box:  

• The Sheet Name Selector enables the user to select which sheet is to be placed in the next 
Layout operation.  The drop down list displays all sheets in the currently attached Sheet 
Library. 

• The Plot Scale text item determines the scale at which sheets will be placed in the 
layout.dgn. 

18.3  Primary Work Flow 
The approach taken by this application is to represent the reference-clipping boundary of each Port 
on each Sheet.  The clipping boundary is represented by MicroStation Shapes, referred to as Clipping 
Shapes. 

For each project, there is one design file which contains all of the Clipping Shapes for a project, for 
example, layout.dgn.  All design elements exist in files referenced to layout.dgn.  It is recommended 
that layout.dgn have only Clipping Shapes in it. 

The Primary Work Flow consists of two operations: 

• Layout of sheets – places clipping shapes into layout.dgn file. 
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• Clipping sheets - reads the Clipping Shapes from the Layout dgn and creates new design 
files which include all required reference files which are clipped at the correct boundaries 
along with the Sheet Cell and other annotations. 

 

There are two options for Clipping Sheets: Rotate View and Rotate Reference. 

When Sheets are clipped using the Rotate View option, the sheet cell and the view are moved and 
rotated such that they are coordinately correct with the clipping shape of Port One.  This arrangement 
allows only one sheet per design file. 

When Sheets are clipped using the Rotate Reference option, the sheet cell and view are not rotated.  
The reference files are rotated and moved to be in the correct location with respect to the sheet cell.  
The arrangement allows multiple sheets to be placed in one design file. 

18.4   Ports 
Each Sheet consists of one or more Ports.  A Port can be considered a window into the design.  For 
each sheet that is placed into a layout.dgn, each Port on that sheet is placed as a Clipping Shape. 

18.4.1   Port Types 
There are three types of Ports: Plan, Profile, and Tabular Data.  It should be noted the 2001 plus 
version of Plan and Profile Sheet Composition does not place tabular data values.  The application 
places Clipping Shapes designed to include Tabular Data.  The actual placement of the Tabular Data 
values is accomplished by the Draw Tabular Annotation (Sheet Clip Mode) tool in coordination with 
the Plan and Profile Sheet Composition application. 

18.4.2   Port Information 
Before laying out sheets, each Port must have its Port Information filled out.  The Port Information 
Dialog boxes are opened by double-clicking the corresponding row in the Layout Dialog box. 

Plan Ports only need the controlling chain, an offset value, and the name of the motif file for the given 
Port.  If the “Use Current Design File” option is selected, Current will be displayed in the dialog box 
instead of a Motif File name. 

Motif files are used to determine reference file attachment.  

Profile Ports require the name of the controlling profile in addition to all the information found in a 
profile cell. 

Tabular Data Ports require the same kind of information that Profile Ports do, but also may optionally 
have the ability to stagger the placement of the ports.  This staggering allows the Clipping Shapes to 
be longer without conflicting so that they may accommodate margin labels. 

18.5   Sheet View Attributes 
Two options are supported for Sheet View Attributes: 

Use Current Design File – All reference file attachments, active levels, etc., are based on the current 
design file.  An optional toggle is supported to Save the Full Path of reference files.  This toggle is 
only for the design file that contains the clipping shapes. 
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Customize with Motif Files - A blank file is utilized as a pattern file for the reference file 
attachments.  Also levels can be turned on or off as desired.  We call these files motif files.   

18.5.1   Use Current Design File 
The user can control reference file attachment without the use of Motif Files by selecting the Use 
Current option for Sheet View Attributes.  When this option is used, the Current dgn file (in which 
clipping shapes have been layed out) is used like a Motif file in that it’s reference file attachment 
information carries over to each Port during Clipping. 

Also the design file containing the clipping shapes will be attached as a reference file for each port to 
accommodate users that wish to place there clipping shapes in the proposed design file. 

The advantage of Use Current Design File is that the user does not need to concern themselves with 
setting up motif files.  What they see in the layout design file is what they will get in clipped sheet files.  
However, when Use Current Design File is that selected option, it is not possible to have different 
reference file settings for different Ports on the same sheet.  All Ports must have the same 
attachment information and can’t be customized. 

The Save Full Path toggle is used when the sheets will be placed in a different directory than the 
reference files. 

NOTE:  If the sheets are to be placed in a different directory, then the reference files must be 
attached to the current design file with “Save Full Path” toggled on. 
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18.5.2   Customize With Motif Files 
It is sometimes necessary to have two or more Ports on a sheet which have differing reference file 
attachment settings.  This could happen with two Plan Ports which cover the same area but show 
different aspects of the project.  For example, the top Port would show the proposed design and the 
bottom Port would show traffic control.  This could be considered as the two Ports on the same sheet 
having different themes or different motifs. 

The question arises as to how the various reference file settings are to be controlled for each Port.  
This is done by using another design file to serve as a pattern for the reference file attachment 
information.  For every Port, there would be a motif file specified by its file name.  The Ports on each 
sheet may have the same or different Motif Files. 

During a Clip operation, the reference file attachment information is read from the motif file for each 
Port.  When a Port is placed into the final sheet file, all reference files which are attached to the 
corresponding Motif File are attached to the final sheet design file.  All reference level view on/off 
settings of the motif file are also applied to the reference file attachment in the final sheet design file.  
Note the clipping shapes are still used to define the Clip Boundary of each reference file associated 
with that Port. 

In the example described above of a sheet with Design and Traffic Control, the top Port could have a 
Motif File named design_motif.dgn.  The bottom Port could have a Motif File named Traffic_motif.dgn.  
At any time before sheets are clipped, the Motif Files (which would normally be blank) must be 
opened, desired levels should be active, and the reference files attached.  The reference file names 
and their paths used for the motif file must match exactly to the reference files and associated paths 
in the original file.  Therefore, the user will normally set up the motif files on a project by project basis, 
unless an organization has a standardized set of file naming conventions and level structure utilized 
on every project, where a single set can be developed for the entire organization. 

NOTE:  If the sheets are to be placed in a different directory, then the reference files must be 
attached to the motif file with “Save Full Path” toggled on.   
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18.6   Sheet Composition 
When the Sheet Composition tool is accessed, the dialog box depicted below opens. 

 

The graphic illustrates the various values required in the dialog box.  Directly below, four options are 
supported, as illustrated in the exploded view above: 

• By Begin Station/Overlap 
• By Station Range:  Inside Out 
• By Station Range:  Outside In 
• By Station Range:  Radial 
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18.6.1   By Begin Station/Overlap Option 
When the By Begin Station/Overlap option is selected, the Clip group box containing the Drawing 
parameters, Overlap options and associated fields as depicted in the graphic below: 

 

Before these options are reviewed, a discussion of the Active Drawing Area, located within the Clip 
group box, is warranted.  Several dimensions are found within the Clip group box.  These include: 

• Maximum Drawing Area (display only) 
• Horizontal 
• Drawing Shown 
• Vertical 
• Active Drawing Area (display only, calculated by GEOPAK) 
 

The graphic below illustrates each dimension for the subject sheet.  In addition, a portion of the 
adjoining sheet to the left is shown in order to depict the overlap.  Notice that the alignment is also 
displayed from approximately station 289+00 to 292+00. 

 

18-     VDOT ROAD 1 Training GEOPAK 2001MR 14  -



___________________________________________________________GEOPAK® 

First, GEOPAK utilizes the Maximum Drawing Area based on the Sheet Name and Scale selected in 
the main Sheet Layout dialog box, in our example, 400.00 x 176.75.  Then the Clip Vertical is 
subtracted twice, once for the top and once for the bottom.  In this case,  

   176.75 - 10 - 10 = 156.75 

which is shown in the Active Drawing Area.  The same method is utilized for the Horizontal 
computations.  The horizontal clip is subtracted twice, once for the right side and once for the left 
side.  In this case,  

   400.00 - 10 - 10 = 380.00 

which is shown in the Drawing Shown and the Active Drawing Area. 

 

Once again referring to the graphic above, GEOPAK considers the Overlap shown on the left side 
between the two adjoining sheets.  The Overlap toggle has two options as depicted in the exploded 
view below: 

 
• Percentage 
• Fixed Distance 

When the Percent option is selected, the designer keys in the desired overlap in percent format in the 
Overlap field.  Note the percent sign (%) is not required.  The Percentage is calculated utilizing the 
Drawing Shown value.  In this example, the 5.26% overlap is 156.75 feet (5.26% of 176.75). 

In our Percentage example, the overlap is 5.26%.  Therefore, a 20.00 foot overlap in clip areas is 
present between successive sheets. 

If the Fixed Distance option is utilized, the Value field is in master units, i.e. feet or meters.   
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When placing sheets on a curve, the chord of the curve where it intersects the inside border is utilized 
to orient the sheet as depicted in the graphic below: 

 

Since the By Begin Station/Overlap Sheet Composition option uses a chord distance to compute 
the length of the sheet, in the area of a curve more stationing will be covered.  On a Plan/Profile 
sheet, this means there will be unequal coverage between the Plan and Profile.  With this in mind, it is 
recommended that By Begin Station/Overlap Sheet Composition option be used for a Plan only 
case. 

18.6.2   By Station Range  Inside Out Option 
The By Station Range:  Inside Out option orients sheets between a rounded station interval.  This 
interval is entered in the Station Range field.  When utilizing this option, the Clip group box also has 
a slightly different look as seen in the graphic depicted below. 

 

Now the Active Drawing Area is not constant, but displays Variable in the output field.   
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The Horizontal keyin has a slightly different meaning which can be best illustrated with an example.  
Let's use 500 feet for the Station Range, and 15 feet Horizontal.  The dialog box is depicted below. 

 

Utilizing the dialog box above, the following sheets are generated. 

 

The first step when the sheets are drawn is to determine the stationing for each sheet.  Our first sheet 
will be oriented between stations 115+00 to 120+00. GEOPAK then expands the sheet clip area by 
the Horizontal keyin distance.  Looking at a detail of the beginning of the project, the clip area is 
expanded fifteen feet before station 115+00 as seen in the graphic below.  Note the inside border is 
the dashed line, and station 115+00 and its associated tick mark are shown. 

 

The curve is calculated slightly different.  The second sheet in this series is on a curve.  The station 
range is 120+00 to 125+00.  A chord is drawn for the curve between stations 120+00 and 125+00 as 
seen in the graphic below. 
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Notice that the inside sheet border is wider than the chord.  The software will extend the chord the 
amount of the Horizontal keyin (in our example, fifteen feet) to establish the vertical edge of the inside 
border as seen in the detail below. 

 

18.6.3   By Station Range  Outside In Option 
The By Station Range:  Outside In option orients sheets between a rounded station interval.  This 
interval is entered in the Station Range field.  When utilizing this option, the Clip group box also has 
a slightly different look as seen in the graphic depicted below. 

The Outside In option is slightly different as seen in the dialog box below. 

 

The Clip Area is no longer variable, but a constant based on the Sheet Size as well as the 
Horizontal and Vertical fields.  In our example, the same 500 feet is keyed in.  When generating the 
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sheets, GEOPAK determines the center of the sheet, and the corresponding station.  In our example 
the midpoint of the stationing for the sheet from 120+00 to 125+00 is 122+50.  This point will be 
placed at the midpoint of the sheet as depicted in the drawing below: 

 

Since the clip area covers a constant station range, the length of the clipping shape will vary 
depending on the curvature of the alignment. 

18.6.4   By Station Radial Option 
The By Station Range:  Radial option orients sheets between a rounded station interval.  This 
interval is entered in the Station Range field.  An example best describes how this feature works.  In 
the dialog box below, each sheet has a station range of 500 feet.  Based on the station ranges in the 
bottom of the dialog box, the first sheet would encompass station 120+00 to 125+00, while the 
second sheet would include stations 125+00 to 130+00. 

 

To draw this second sheet, GEOPAK locates the midpoint station 122+50, which in our example is on 
a curve.  Utilizing the chord of curve as the vertical center, GEOPAK draws the top and bottom of the 
clip regions 217.5 feet from the chord, making the clip region 435 feet high.  This is computed from 
the sheet size of 475 minus the vertical keyin of 20 for the top and 20 for the bottom, resulting in a 
435 feet height. 

In the next step, GEOPAK moves to station 125+00 and draws the clip border radial to the alignment 
at the specified station until it intersects with the previously computed top and bottom clip regions.  
The same process is repeated at the other end of the sheet, i.e., 130+00.  Therefore, the inside clip 
region is trapezoidal as depicted in the graphic below. 
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Since the clip area covers a constant station range, the length of the clipping shape will vary 
depending on the curvature of the alignment. 

 

Note:  Any time sheets are deleted from the file using MicroStation commands, the file 
must be compressed before laying out the sheets again. 
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LAB 18:   Plan and Profile Sheets 
18.1   Getting Started 

Step 1. Execute C:\data\geo\VDOT\road1\LAB18.EXE. 

Step 2. Open the Microstation file c:\data\geo\VDOT\road1\d17682work.dgn.   

 Access Project Manager. 

18.2   Plan Sheet Layout Process 
Step 1. Click the Plan & Profile Sheets button from the Road Project: 17682.prj workflow 

dialog box. 

Step 2. Create a run named Plan to set up the plan sheets. Initially, the dialog box will appear 
similar to the one shown below. 

 

Step 3. Select Settings>Sheet Layout.  Change “Sheet View Attributes” option to Customize 
with Motif Files then click OK.  The completed dialog box is shown below. 

 

Step 4. On the GEOPAK Sheet Layout dialog box, select PLAN from the sheet list then set the 
scale to 25.0000 ft/in.  The GEOPAK Sheet Layout dialog box should appear as below. 
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Step 5. Press the Sheet Composition icon.  Populate the Sheet Composition dialog box as 
below. 

 

 

Note:  The Vertical setting will trim off the top and bottom of the clipping shape so that 
plan data will not be placed inside the title blocks on the sheet. 

 

Step 6. Dismiss the Sheet Composition dialog box by pressing the X in the upper right hand 
corner. 

Step 7. Press the Layout Sheets icon.  Click OK on the information modal. 

Step 8. Press the Open GEOPAK Job icon then select job number 101. 

Step 9. Double click on Port 1.  Set the Chain to Mainline by selecting it from the option list. 

Step 10. Press the Create Motif File icon. 
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Step 11. Populate the Create Plan Motif File dialog box as below. 

 

 

Note:  The Seed File can be selected by pressing the Select Seed Motif File icon then 
selecting Plan-Motif.dgn.  The Target File name should be entered manually. 

 
Step 12. Press OK on the Create Plan Motif File dialog box.  A file named Plan-Motif.dgn should 

be created in the working directory and the Plan Port Data dialog box should appear as 
below. 

 

Step 13. Press OK on the Plan Port Data dialog box.  The Layout Sheets dialog box should now 
appear as below. 

 

Step 14. In the Layout Sheets dialog box, set the Extend value for the Begin Station to –200.00.  
This will force the first sheet to end at Station 205+00.00.  The dialog box should appear 
as below.  Click the Layout 4 Sheets button to draw the clipping shapes into the design 
file. 
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 4 clipping shapes should be placed for the Plan port. 

Step 15. Dismiss the Layout Sheets dialog box by pressing the X in the upper right hand corner. 

Step 16. Exit the Plan and Profile Sheet dialog box and save your run.  Review the results. 

18.3   Profile Sheet Layout Process 
Step 1. Click the Plan & Profile Sheets button from the Road Project: 17682.prj workflow 

dialog box. 

Step 2. Create a run named Profile to set up the profile sheets. The dialog box should appear as 
shown below. 

 

Step 3. Select Settings>Sheet Layout.  Change “Profile Stair Stepping” option to On and 
“Sheet View Attributes” option to Customize with Motif Files then click OK.  The 
completed dialog box is shown below. 

 

Step 4. On the GEOPAK Sheet Layout dialog box, select PROFILE WITH SUPER from the 
sheet list then set the scale to 25.0000 ft/in.  The GEOPAK Sheet Layout dialog box 
should appear as below.  
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Step 5. Press the Sheet Composition icon.  Populate the Sheet Composition dialog box as 
below. 

 

Step 6. Dismiss the Sheet Composition dialog box by pressing the X in the upper right hand 
corner. 

Step 7. Press the Layout Sheets icon. 

Step 8. Press the Open GEOPAK Job icon then select job number 101. 

Step 9. Double click on Port 1.  Set the Profile to Mainline by selecting it from the option list. 

Step 10. Populate the remaining fields on the Profile (Port 1) dialog box by pressing the Identify 
Cell button then graphically identifying the profile cell.  The dialog box should appear as 
below. 
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Note:  The X and Y coordinates may be different than what is shown in the dialog box.  
They should match the insertion points of your profile cell. 

 

Step 11. Press the Create Motif File icon. 
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Step 12. Populate the Create Profile Motif File dialog box as below. 

 

 

Note:  The Seed File can be selected by pressing the Select Seed Motif File icon then 
selecting Profile-Motif.dgn.  The Target File name should be entered 
manually. 

 

Step 13. Press OK on the Create Profile Motif File dialog box.  A file named Profile-Motif.dgn 
should be created in the working directory and the Profile (Port 1) dialog box should 
appear as below. 

 

Step 14. Press OK on the Profile (Port 1) dialog box.  The Layout Sheets dialog box should now 
appear as below. 
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Step 15. Double click on Port 2.  Set the Profile to Mainline by selecting it from the option list. 

Step 16. Populate the remaining fields on the Tabular (Port 2) dialog box by pressing the Identify 
Cell button then graphically identifying the profile cell.  The dialog should appear as 
below. 

 

Step 17. Press the Create Motif File icon. 
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Step 18. Populate the Create Profile Motif File dialog box as below. 

 

 

Note:  The Seed File can be selected by pressing the Select Seed Motif File icon then 
selecting SuperDia-Motif.dgn.  The Target File name should be entered 
manually. 

 

Step 19. Press OK on the Create Tabular Data Motif File dialog box.  A file named SuperDia-
Motif.dgn should be created in the working directory and the Tabular (Port 2) dialog box 
should appear as below. 
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Step 20. The X an Y Coordinates need to be reset in order for the clipping shapes to be placed on 
the Superelevation Diagram.  Press the By DP button then snap to the line immediately 
left of the Superelevation Diagram lines.  The dialog should appear as below. 

 

Step 21. Press OK on the Tabular (Port 2) dialog box.  The Layout Sheets dialog box should 
now appear as below. 

 

Step 22. In the Layout Sheets dialog box, set the Extend value for the Begin Station to –200.00.  
This will force the first sheet to end at Station 205+00.00.  The dialog box should appear 
as below.  Click the Layout 4 Sheets button to draw the clipping shapes into the design 
file. 
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 4 clipping shapes should be placed for the Profile and Tabular Data ports. 

Step 23. Dismiss the Layout Sheets dialog box by pressing the X in the upper right hand corner. 

Step 24. Exit the Plan and Profile Sheet dialog box and save your run.  Review the results. 

18.3   Motif File Setup 
In the following steps we will set up the Motif Files created in the previous section so that the Plan 
view file will be displayed in the Plan Port and the Profile view file will be displayed in the Profile 
and Tabular Data Ports. 

Step 1. Open Plan-Motif.dgn. 

Step 2. Attach d17682des.dgn as a reference file.  Do a Fit View and Save Settings if 
necessary. 

Step 3. Open Profile-Motif.dgn. 

Step 4. Attach d17682prof.dgn as a reference file.  Turn off levels 30 and 63 in the reference 
file.  Do a Fit View and Save Settings if necessary. 

Step 5. Open SuperDia-Motif.dgn. 

Step 6. Attach d17682prof.dgn as a reference file.  Turn off level 63 in the reference file.  Do a 
Fit View and Save Settings if necessary. 

Step 7. Open d17682work.dgn. 

 

Note:  Any design file that needs to be clipped to the sheets should be attached to the 
Motif Files (e.g. Survey, Utilities, Contours, etc.). 

 

18.4   Move The Profile Clipping Shape 
You should notice that the vertical curve data doesn’t fall inside the second Profile Clipping Shape.  In 
the following steps we will move the Profile Clipping Shape utilizing the Modify tools in Plan and 
Profile Sheet Composition. 

All work should be done in c:\data\geo\VDOT\road1\d17682work.dgn.   

Step 1. Click the Plan & Profile Sheets button from the Road Project: 17682.prj workflow 
dialog box.  Access the Profile run. 
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Step 2. Press the Modify Sheets icon.  The dialog box below should appear. 

 

Step 3.  Press the Identify button then graphically select the second Profile Clipping Shape.  The 
dialog box should now appear as below. 

 

Step 4.  Toggle on Bottom Elevation then enter 2000.00 for the elevation.  The dialog box 
should now appear as below. 

 

Step 5.  Press Apply.  Sheet 6, Port 1 should be moved down so that the bottom of the clipping 
shape is at elevation 2000.00. 

Step 6. Dismiss the Modify Sheets dialog box by pressing the X in the upper right hand corner. 

Step 7. Exit the Plan and Profile Sheet dialog box and save your run. 
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18.5   Renumber Sheets 
Step 1. Click the Plan & Profile Sheets button from the Road Project: 17682.prj workflow 

dialog box.  Access the Plan run. 

Step 2. Press the Sheet Number Manager icon. 

Step 3. Select Sequence Numbers 1 through 4 then press the Edit Sheet Number button. 

 

Step 4. Populate the Edit Sheet Number dialog box as below then push OK. 

 

The Sheet Number Manager dialog box should appear as below. 
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Step 5. Select Sequence Numbers 5 through 8 then press the Edit Sheet Number button. 

 

Step 6. Populate the Edit Sheet Number dialog box as below then push OK. 

 

 The Sheet Number Manager dialog box should appear as below. 

 

Step 7. Dismiss the Sheet Number Manager dialog box by pressing the X in the upper right 
hand corner.  Press Yes when prompted to Save Settings. 
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18.6   Clip Plan Sheets 
You should still be in the Plan run from the previous section. 

Step 1. Press the Clip Sheets icon.  Populate the Clip Sheets dialog box as below.  

 

 

Note:  The Sheet Title field will be used to place the Route Number. 

 

Step 2. Click the Process Sheets button to create the plan sheets. 

Step 3. Dismiss the Clip Sheets dialog box by pressing the X in the upper right hand corner. 

Step 4. Exit the Plan and Profile Sheet dialog box and save your run. 

Step 5. Open any of the newly created Plan Sheet files to see the resulting sheets. 
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18.7   Clip Profile Sheets 
The following steps should be done in design file d17682work.dgn. 

Step 1. Click the Plan & Profile Sheets button from the Road Project: 17682.prj workflow 
dialog box.  Access the Profile run. 

Step 2. Press the Clip Sheets icon.  Populate the Clip Sheets dialog box as below.  

 

 

Note:  The Sheet Title field will be used to place the Route Number. 

 

Step 3. Click the Process Sheets button to create the profile sheets. 

Step 4. Dismiss the Clip Sheets dialog box by pressing the X in the upper right hand corner. 

Step 5. Exit the Plan and Profile Sheet dialog box and save your run. 

Step 6. Open any of the newly created Profile Sheet files to see the resulting sheets. 

Step 7. Exit MicroStation. 
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